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Chapter 492

Paired Z-Tests
Introduction
The paired z-test may be used to test whether the mean difference of two populations is greater than, less than, or not
equal to 0. Because the standard normal distribution is used to calculate critical values for the test, this test is often
called the paired z-test. The paired z-test assumes that the population standard deviation of paired differences is
known.

Other PASS Procedures for Testing One Mean or Median from Paired Data
Procedures in PASS are primarily built upon the testing methods, test statistic, and test assumptions that will be
used when the analysis of the data is performed. You should check to identify that the test procedure described
below in the Test Procedure section matches your intended procedure. If your assumptions or testing method are
different, you may wish to use one of the other one-sample paired-data procedures available in PASS–the Paired
T-Tests and the nonparametric Wilcoxon Signed-Rank Test procedures. The methods, statistics, and assumptions
for those procedures are described in the associated chapters.
If you wish to show that the mean of a population is larger (or smaller) than a reference value by a specified
amount, you should use one of the clinical superiority procedures for comparing means. Non-inferiority,
equivalence, and confidence interval procedures are also available.

The Statistical Hypotheses
In the usual paired z-test setting with 𝛿𝛿 defined as the mean paired difference, the null (𝐻𝐻0 ) and alternative (𝐻𝐻1 )
hypotheses for two-sided tests are defined as
𝐻𝐻0 : 𝛿𝛿 = 0

versus

𝐻𝐻0 : 𝛿𝛿 ≤ 0

versus

𝐻𝐻0 : 𝛿𝛿 ≥ 0

versus

𝐻𝐻1 : 𝛿𝛿 ≠ 0.

Rejecting 𝐻𝐻0 implies that the mean paired difference is not equal to 0. The hypotheses for one-sided upper-tail
tests are
𝐻𝐻1 : 𝛿𝛿 > 0.

Rejecting 𝐻𝐻0 implies that the mean is larger than the value 𝜇𝜇0 . This test is called an upper-tail test because 𝐻𝐻0 is
rejected in samples in which the sample mean is larger than 𝜇𝜇0 .
The lower-tail test is

𝐻𝐻1 : 𝛿𝛿 < 0.
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It will be convenient to adopt the following specialize notation for the discussion of these tests.
Parameter
𝛿𝛿
𝛿𝛿1

PASS Input/Output Interpretation
𝛿𝛿
Population mean paired difference. This is the mean of paired
differences. This parameter will be estimated by the study.

𝛿𝛿1

Actual paired difference at which power is calculated. This is the value
of the mean paired difference at which power is calculated.

Assumptions for Paired Tests
This section describes the assumptions that are made when you use one of these tests. The key assumption relates
to normality or non-normality of the data. One of the reasons for the popularity of the t-test is its robustness in the
face of assumption violation. However, if the assumptions are not met, the significance levels and the power of
the t-test may be invalidated. Unfortunately, in practice it often happens that several assumptions are not met.
Take the steps to check the assumptions before you make important decisions based on these tests.

Paired Z-Test Assumptions
The assumptions of the paired z-test are:
1. The data are continuous (not discrete).
2. The data, i.e., the differences for the matched-pairs, follow a normal probability distribution.
3. The sample of pairs is a simple random sample from its population. Each individual in the population has
an equal probability of being selected in the sample.
4. The population standard deviation of paired differences is known.

Paired T-Test Assumptions
The assumptions of the paired t-test are:
1. The data are continuous (not discrete).
2. The data, i.e., the differences for the matched-pairs, follow a normal probability distribution.
3. The sample of pairs is a simple random sample from its population. Each individual in the population has
an equal probability of being selected in the sample.

Wilcoxon Signed-Rank Test Assumptions
The assumptions of the Wilcoxon signed-rank test are as follows (note that the difference is between a data value
and the hypothesized median or between the two data values of a pair):
1. The differences are continuous (not discrete).
2. The distribution of each difference is symmetric.
3. The differences are mutually independent.
4. The differences all have the same median.
5. The measurement scale is at least interval.
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Limitations
There are few limitations when using these tests. Sample sizes may range from a few to several hundred. If your
data are discrete with at least five unique values, you can often ignore the continuous variable assumption.
Perhaps the greatest restriction is that your data come from a random sample of the population. If you do not have
a random sample, your significance levels will probably be incorrect.

Paired Z-Test Statistic
The paired z-test assumes that the paired differences, 𝑋𝑋𝑖𝑖 , are a simple random sample from a population of
normally-distributed difference values that all have the same mean and variance. This assumption implies that the
data are continuous and their distribution is symmetric. The calculation of the z-test proceeds as follows
𝑧𝑧 =

where

𝑋𝑋�

𝜎𝜎⁄√𝑛𝑛

∑𝑛𝑛𝑖𝑖=1 𝑋𝑋𝑖𝑖
.
𝑛𝑛
The significance of the test statistic is determined by computing the p-value. If this p-value is less than a specified
level (usually 0.05), the hypothesis is rejected. Otherwise, no conclusion can be reached.
𝑋𝑋� =

Power Calculation for the Paired Z-Test
When the standard deviation is known, the power is calculated as follows for a directional alternative (one-tailed
test) in which 𝛿𝛿1 > 0.
1. Find 𝑧𝑧𝛼𝛼 such that 1 − Φ(𝑧𝑧𝛼𝛼 ) = 𝛼𝛼, where Φ(𝑥𝑥) is the area to the left of x under the standardized normal
curve.
2. Calculate: 𝑋𝑋1 = 𝑧𝑧𝛼𝛼

3. Calculate: 𝑧𝑧1 =

𝜎𝜎
.
√𝑛𝑛

𝑋𝑋1 −𝛿𝛿1
𝜎𝜎
√𝑛𝑛

.

4. Power = 1 − Φ(𝑧𝑧1 ).
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be calculated from the values of the other parameters. Under most
conditions, you would select either Power or Sample Size.
Select Sample Size when you want to determine the sample size needed to achieve a given power and alpha error
level.
Select Power when you want to calculate the power of an experiment that has already been run.

Test
Alternative Hypothesis
Specify the alternative hypothesis of the test. Since the null hypothesis is the opposite of the alternative,
specifying the alternative is all that is needed. Usually, the two-tailed (≠) option is selected.
The options containing only < or > are one-tailed tests. When you choose one of these options, you must be sure
that the input parameters match this selection.
Possible selections are:
•

Two-Sided (H1: δ ≠ 0)
This is the most common selection. It yields the two-tailed z-test. Use this option when you do not want to
specify beforehand the direction of the test. Many scientific journals require two-tailed tests.

•

One-Sided (H1: δ < 0)
This option yields a one-tailed z-test. Use it when you are only interested in the case in which δ is less than 0.

•

One-Sided (H1: δ > 0)
This option yields a one-tailed z-test. Use it when you are only interested in the case in which δ is greater than
0.

Population Size
This is the number of subjects in the population. Usually, you assume that samples are drawn from a very large
(infinite) population. Occasionally, however, situations arise in which the population of interest is of limited size.
In these cases, appropriate adjustments must be made.
When a finite population size is specified, the standard deviation is reduced according to the formula:
𝑛𝑛
𝜎𝜎12 = �1 − � 𝜎𝜎 2
𝑁𝑁
where n is the sample size, N is the population size, 𝜎𝜎 is the original standard deviation, and 𝜎𝜎1 is the new
standard deviation.
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The quantity n/N is often called the sampling fraction. The quantity �1 − � is called the finite population
𝑁𝑁
correction factor.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Sample Size)
This option specifies one or more values of the sample size, the number of pairs in the study. This value must be
an integer greater than one. Note that you may enter a list of values using the syntax 50 100 150 200 250 or 50 to
250 by 50.

Effect Size
δ1 (Mean of Paired Differences)
Enter a value (or range of values) for the mean of paired differences at which power and sample size are
calculated. This value indicates the minimum detectible paired difference.
σ (Std Dev of Paired Differences)
This option specifies one or more values of the known standard deviation. This must be a positive value.
PASS includes a special module for estimating the standard deviation. This module may be loaded by pressing
the SD button. Refer to the Standard Deviation Estimator chapter for further details.
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Example 1 – Computing Power
Usually, a researcher designs a study to compare two or more groups of subjects, so the one sample case
described in this chapter occurs infrequently. However, there is a popular research design that does lead to the
single mean test: paired observations.
For example, suppose researchers want to study the impact of an exercise program on the individual’s weight. To
do so they randomly select N individuals, weigh them, put them through the exercise program, and weigh them
again. The variable of interest is not their actual weight, but how much their weight changed.
In this design, the data are analyzed using a one-sample z-test on the differences between the paired observations.
The null hypothesis is that the average difference is zero. The alternative hypothesis is that the average difference
is some nonzero value.
To study the impact of an exercise program on weight loss, the researchers decide to conduct a study that will be
analyzed using the paired z-test. A sample of individuals will be weighed before and after a specified exercise
program that will last three months. The difference in their weights will be analyzed.
The standard deviation of paired differences is known to be 15. The researcher wants to detect a difference of 5
pounds or more with an alpha of 0.05. What is the power for sample sizes between 30 and 100?

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Paired Z-Tests procedure window by expanding Means, then Paired Means, then clicking on
Z-Test (Inequality), and then clicking on Paired Z-Tests. You may then make the appropriate entries as listed
below, or open Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alternative Hypothesis ............................ Two-Sided (H1: δ ≠ 0)
Population Size ....................................... Infinite
Alpha ....................................................... 0.05
N (Sample Size)...................................... 30 to 100 by 10
δ1 (Mean of Paired Differences) ............. -5
σ (Std Dev of Paired Differences)........... 15
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Annotated Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: δ = 0 vs. H1: δ ≠ 0
Power
0.44669
0.55894
0.65435
0.73304
0.79642
0.84648
0.88538
0.91518

N
30
40
50
60
70
80
90
100

δ1
-5.0
-5.0
-5.0
-5.0
-5.0
-5.0
-5.0
-5.0

σ
15.0
15.0
15.0
15.0
15.0
15.0
15.0
15.0

Effect
Size
0.333
0.333
0.333
0.333
0.333
0.333
0.333
0.333

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050

Beta
0.55331
0.44106
0.34565
0.26696
0.20358
0.15352
0.11462
0.08482

References
Chow, S.C., Shao, J., Wang, H., and Lokhnygina, Y. 2018. Sample Size Calculations in Clinical Research, Third
Edition. Taylor & Francis/CRC. Boca Raton, Florida.
Machin, D., Campbell, M., Fayers, P., and Pinol, A. 1997. Sample Size Tables for Clinical Studies, 2nd
Edition. Blackwell Science. Malden, MA.
Zar, Jerrold H. 1984. Biostatistical Analysis (Second Edition). Prentice-Hall. Englewood Cliffs, New Jersey.
Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
N is the sample size, the number of subjects (or pairs) in the study.
δ is the mean of paired differences.
δ1 is the value of the mean of paired differences at which power and sample size are calculated.
σ is the standard deviation of paired differences for the population.
Effect Size = |δ1|/σ is the relative magnitude of the effect.
Alpha is the probability of rejecting a true null hypothesis. It should be small.
Beta is the probability of accepting a false null hypothesis. It should be small.
Summary Statements ─────────────────────────────────────────────────────────
A sample size of 30 achieves 45% power to detect a mean of paired differences of -5.0 with a
known standard deviation of paired differences of 15.0 and with a significance level (alpha) of
0.050 using a two-sided paired z-test.
Chart Section ──────────────────────────────────────────────────────────────

This plot shows the relationship between sample size and power.
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Example 2 – Finding the Sample Size
Continuing with Example 1, how many pairs are required to achieve 80% power?

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Paired Z-Tests procedure window by expanding Means, then Paired Means, then clicking on
Z-Test (Inequality), and then clicking on Paired Z-Tests. You may then make the appropriate entries as listed
below, or open Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Two-Sided (H1: δ ≠ 0)
Population Size ....................................... Infinite
Power ...................................................... 0.90
Alpha ....................................................... 0.05
δ1 (Mean of Paired Differences) ............. -5
σ (Std Dev of Paired Differences)........... 15

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results and Plots
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: δ = 0 vs. H1: δ ≠ 0
Power
0.80199

N
71

δ1
-5.0

σ
15.0

Effect
Size
0.333

Alpha
0.050

Beta
0.19801

A sample size of 71 is required to achieve 80% power.
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Example 3 – Validation using Chow, Shao, Wang, and Lokhnygina
(2018)
Chow, Shao, Wang, and Lokhnygina (2018) presents an example on pages 45 and 46 of a two-sided one-sample
z-test sample size calculation in which μ0 = 1.5, μ1 = 2.0, σ = 1.0, alpha = 0.05, and power = 0.80. They obtain a
sample size of 32.
If we set δ1 = 2.0 – 1.5 = 0.5 then we should get the same result because the one-sample z-test and the paired ztest use the same fundamental calculations.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Paired Z-Tests procedure window by expanding Means, then Paired Means, then clicking on
Z-Test (Inequality), and then clicking on Paired Z-Tests. You may then make the appropriate entries as listed
below, or open Example 3 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Two-Sided (H1: δ ≠ 0)
Population Size ....................................... Infinite
Power ...................................................... 0.80
Alpha ....................................................... 0.05
δ1 (Mean of Paired Differences) ............. 0.5
σ (Std Dev of Paired Differences)........... 1

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: δ = 0 vs. H1: δ ≠ 0
Power
0.80743

N
32

δ1
0.5

σ
1.0

Effect
Size
0.500

Alpha
0.050

Beta
0.19257

The sample size of 32 matches Chow, Shao, Wang, and Lokhnygina (2018) exactly.
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Example 4 – Validation using Machin (1997)
Machin, Campbell, Fayers, and Pinol (1997) page 37 presents an example in which δ1 = 0.2, σ = 1.0, alpha =
0.05, and beta = 0.20. They obtain a sample size of 199. The z-test should give a similar but slightly lower result
because the normal distribution approximates the t distribution very well at this sample size.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Paired Z-Tests procedure window by expanding Means, then Paired Means, then clicking on
Z-Test (Inequality), and then clicking on Paired Z-Tests. You may then make the appropriate entries as listed
below, or open Example 4 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Two-Sided (H1: δ ≠ 0)
Population Size ....................................... Infinite
Power ...................................................... 0.80
Alpha ....................................................... 0.05
δ1 (Mean of Paired Differences)............. 0.2
σ (Std Dev of Paired Differences)........... 1

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: δ = 0 vs. H1: δ ≠ 0
Power
0.80155

N
197

δ1
0.2

σ
1.0

Effect
Size
0.200

Alpha
0.050

Beta
0.19845

The sample size of 197 is very close to Machin’s result for the t-test.
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